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DETAILED DESCRIPTION OF PROBLEM:

In my capacity as a Systems Architect for Comhem, an MSO in Sweden with roughly 750 000 modems, I have become aware of specific problems that I believe might be facing other MSOs with respect to DHCP retry behaviors defined in the eRouter specification.

When we started our inquiry with CableLabs, it was pointed out that DHCP retry behavior in the eRouter specification was taken directly from the MULPI specification. We then started to look at the CMs we have in the field, and how they behave when their IP lease time expires. What we found in surveying our CMs in the field is that they reset if their IP lease expires, without exception. The specific details of this behavior does not appear to be described in either eRouter or MULPI.

Comhem uses lease times of 48 hours for CMs and E-MTAs and use a 2-hour lease times for CPEs and eRouters. All addresses assigned are from the public IP address space. 
 
I understand and share the concerns of the other MSOs that if we have a massive power outage that the DHCP server needs to be protected from floods of requests, but we feel that these considerations are already addressed in the IP acquisition process, where an eRouter has to acquire an IP in order to reach an operational state, initializing its LAN interfaces and IP applications.

If 5 DISCOVERS retries fail, a modem will be forced to reset. However in the case where an embedded CM is already REGISTERED and it is the eRouter’s lease that expires, there is nothing in the specification that allows the eRouter to recover under such circumstances. 

We have experienced recurring issues during the upgrade of our distribution and access network equipment that has resulted in extended service outages due to unexpected behavior on the part of the CM and eRouter. During a recent upgrade of the firewalls that protect the provisioning complex, we discovered that it took extraordinary measures and several hours to recover the CMs and eRouters on our access network due to the DHCP retry behavior of the CMs and eRouters. 

Specifically, the fault resulted in roughly 200,000 eRouters out of 650,000 failing to recover after the DHCP servers were once again available. We identified the cause of the fault during root cause analysis and discovered that the eRouter’s IP lease would reach expiration while the device’s embedded CM’s lease remained valid, resulting in the eRouter no longer forwarding traffic on the LAN once it had made 5 retry attempts and given up attempting further retries. Per the specification, the eRouter will only attempt to retry 5 times, but will then cease to retry until the device is reset. The eRouter specification demands that the eRouter stop forwarding traffic when its IP address expires, disrupting the LAN-side of the router.  

From an operational perspective, we observed no alarms when the eRouters on our network stopped attempting to reach the DHCP servers.  All of the embedded CMs remained online and registered, but the customers didn’t have any service, resulting in many complaints being received by the call center.  

We analyzed the eRouter specification and confirmed that the retry behavior defined there prevents further DHCP retry attempts after 5 retries have been attempted.  Some of the eRouters we deployed followed this behavior, while others appeared to deviate from the specification and continued to retry, sending DHCP DISCOVER messages every 2 minutes. The devices violating the currently defined DHCP retry behavior became operational immediately after we finished upgrading the firewalls that protect our provisioning system and access to the DHCP servers was restored.  This was not the case for eRouters that followed the specification. The proposed change to eRouter is what we feel best reflects both the real-life scenarios and the behavior we observed that many of our eRouters already had that has proven to work well. We feel the current behavior creates problems that cannot be easily resolved by other means than by rectifying the issue in the specification.

Several years ago, the customer’s PC was connected directly to the CM, but with the introduction of the eRouter, the PC was connected directly to the eRouter. In those days a simple reset would have done fine. As the years have passed, more and more network and home automation appliances have been introduced into the customer’s home and most of those continue to work even after the link to the Internet is lost.

I have proposed a change to an existing requirement that I feel best supports maintaining continuity on the customer’s LAN during an Internet outage. “REQ17261 The eRouter MUST NOT forward IPv4 traffic between its Customer-Facing Interface and its Operator-Facing Interface if, at any time, it does not have an IPv4 address for its Operator-Facing Interface. “ The previous wording stated that the eRouter is not allowed to forward any traffic at all, not even on the LAN-side, if the eRouter’s IP lease expires. My suggested change only prevents the eRouter from attempting to forward traffic from LAN to WAN if the eRouter lease expires, while local LAN traffic is still permitted, if the vendor or MSO so chooses. We feel that the currently defined behaviors create problems in production that cannot be easily resolved by other means than rectifying the issue in the specification.

The proposed change is only applicable for the WAN interface of the eRouter, not the CM interface of the embedded CM inside the eRouter. The CM interface still falls under MULPI Specification.


CHANGE DETAILS FOR THE SPECIFICATION:
Complete Engineering Change details for the specification are contained in the following embedded file: 



CHANGE DETAILS FOR THE TEST PLAN (ATP):
Complete Engineering Change details for the test plan is contained in the following embedded file: 
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7 [bookmark: _Ref350421575][bookmark: _Toc462383424]IPv4 Provisioning[footnoteRef:1] [1:  Section updated per eRouter-N-13.1127-4 on 3/21/14 by PO, updated by eRouter-N-15.1371 on 11/6/15 by PO.] 


The normative requirements of this section are mandatory for an eRouter that implements the 'IPv4 Protocol Enabled' mode and/or the 'Dual IP Protocol Enabled' mode as defined in Section 6.

REQ17256 After the CM has reached operational state, if the eRouter is configured to route IPv4 packets, the eRouter MUST use DHCPv4 [RFC 2131] via its Operator-Facing Interface in order to obtain an IP address and any other parameters needed to establish IP connectivity, as illustrated in Figure 7‑1. 







[bookmark: _Ref296602330][bookmark: _Toc462383565]Figure 7‑1 - IPv4 Provisioning Message Flow



The eRouter may receive multiple DHCPOFFER messages in response to its DHCPDISCOVER message. REQ17257 If a received DHCPOFFER message does not include all of the required DHCPv4 fields and options as described in Section 7.2, the eRouter MUST discard the DHCPOFFER message and wait for another DHCPOFFER message.  REQ17258 If none of the received DHCPOFFER messages contain all the required DHCPv4 fields and options, the eRouter MUST retransmit the DHCPDISCOVER message. 

REQ17422 The backoff values for retransmission of DHCPDISCOVER messages SHOULD be chosen according to a uniform distribution between the minimum and maximum values in the rows of Table 7-1. 

[bookmark: _Ref141581914][bookmark: _Toc462383577]Table 7-1 - eRouter DHCP Retransmission Interval

		Backoff Number 

		Minimum (sec.)

		Maximum (sec.)



		1

		3

		5



		2

		7

		9



		3

		15

		17



		4

		31

		33



		5

		63

		65



		>6

		119

		121





REQ17423 The eRouter SHOULD also implement a different retransmission strategy for the RENEWING and REBINDING states, as recommended in [RFC 2131], which is based on one-half of the remaining lease time.

REQ17259 The eRouter MUST limit the number of retransmissions of the DHCPDISCOVER and DHCPREQUEST messages to five or fewer.  REQ17260 The eRouter MUST NOT forward IPv4 traffic between its Customer-Facing Interface and its Operator-Facing Interface until it has completed IPv4 provisioning, including the successful receipt of a DHCPACK message.  REQ17261 The eRouter MUST NOT forward IPv4 traffic between its Customer-Facing Interface and its Operator-Facing Interface if, at any time, it does not have an IPv4 address for its Operator-Facing Interface. REQxxxxx The eRouter MUST still be capable of forwarding IPv4 traffic between its customer facing interfaces, at any time, when the eRouter has been provisioned for IPv4 single or dual stack operation, even if the Operator-Facing Interface IP Lease expires.

REQ17262 The eRouter MUST be able to accept a unicast response from the DHCP server/relay agent. 
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NOTE - This embedded document is unprotected; therefore, all Word features are available including: Track changes, document compare, all menus and toolbars, etc. For further instructions on how to complete this Details form, see the embedded instructions document in the master EC Form.



ENGINEERING CHANGE DOCUMENT DETAILS

[bookmark: ECID]EC Identifier:  

(to be inserted by CableLabs)

[bookmark: TitleOfEC]Title of EC:  

(to be inserted by CableLabs)

		Change Details - Revision History



		If modifying the change details from the original submitted version, please complete the following information. Include a brief description of what is different in this version compared to the previously posted version:





Date of the revised EC: 

Description of new version: 

Proposed Test Plan Changes (PLEASE INCLUDE TEST CASE NUMBER, TITLE, AND AFFECTED PORTION.) (MANDATORY FOR ECOS AND ECNS) Please include any additions or modifications to existing Acceptance Test Plan (ATP) Test Cases that are a result of the specification changes noted separately. Changes can affect multiple Test Cases. To submit more than 3 changes, copy the numbered change table and paste, updating the change numbers.



Test Plan Changes

Name of test plan affected:



		ATP CHANGE #1

		



		TEST CASE #

		TEST CASE TITLE

		AFFECTED PORTION (PROCEDURE #, INTRO, ETC.)



		

		

		









		ATP CHANGE #2

		



		TEST CASE #

		TEST CASE TITLE

		AFFECTED PORTION (PROCEDURE #, INTRO, ETC.)



		

		

		









		ATP CHANGE #3

		



		TEST CASE #

		TEST CASE TITLE

		AFFECTED PORTION (PROCEDURE #, INTRO, ETC.)



		

		

		









End of Request Details
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Instructions for completing Change Details sections

The following steps MUST be followed in the order listed. This ensures technical reviewers and editors can accurately review and update the document:

1. Turn OFF Track Changes from the Review tab in Word or by right-clicking in the Status bar. For more information, [image: click here].

2. Copy and Paste ALL original text from Specification or Test Plan.

3. Turn ON Track Changes. Any deletions and additions you make will be marked on the text. The colors that are used are defined in the Change Tracking Options. For more information [image: click here]. 

Note 1: If Track Changes are not used, this EC will be returned to you for correction to include the Track Changes.

Note 2: In rare circumstances, if extensive changes are necessary in multiple sections or throughout the document, the entire document to be changed may be embedded in the EC form, replacing the existing embedded Changed Detail document. Check with project spec lead for further details.

IMPORTANT NOTE! You MUST save the EC form after closing the embedded document to retain your edits!!

To compare most the recent version of this EC with previous versions of this EC, save the embedded documents to your local drive with unique file names prior to comparing.



Instructions on how to embed a file within a Word 2010 document.

1. Open your EC form in Windows 2010. From the Insert Tab at the top of the Word window, select 'Object'.







2. Click the 'Object' option: 

3. On the "Create from File" tab, browse to select the appropriate file.







4. When the file is selected, select the ' Display as icon' box.

5. Remove all but the file name from the 'File name' box and press OK (in other words, delete the file path if it appears on your computer). 







6. Press OK again and the document is now embedded into your EC form.

7. If you encounter problems embedding the file in the EC form, please send the embedded document form as a separate file with the EC form when you submit it to docsis_ec@cablelabs.com. 

[bookmark: _How_to_Turn][bookmark: _Ref310949641]How to Turn on Track Changes

		Turn on Track Changes from Review Tab

		[image: track changes button]



		[bookmark: _GoBack]OR

		



		Turn on Track Changes from Status Bar

		[image: trkchgs right-click]







[bookmark: _Change_Tracking_Options][bookmark: _Ref310949829]Change Tracking Options



[image: track changes options]

If you use the colors defined above, your inserted text will be blue underlined and your deletions will be red with strikethrough. The changed lines will also be marked with a revision bar in the left margin.

[bookmark: _Toc352933757]Deadlines for Submission

The deadline for submitting proposed ECRs and revisions to ECRs and ECOs is 8:00am Mountain Time on Wednesday of each week for posting that week. Any changes to this schedule will be posted to the appropriate DOCSIS reflectors. Newly proposed ECs and revisions to ECs received after that time will not be posted until the following week.

[bookmark: _Toc352933758]Submitting a new ECR

To officially submit a new ECR or a revision to an existing EC, it must be sent via email to docsis_ec@cablelabs.com by the submission deadline noted above.  Please do not send it to individuals at CableLabs. The docsis_ec@cablelabs.com address will distribute the document to all of the necessary internal personnel for processing.

[bookmark: _Toc352933759]Helpful Information for Writing ECs

When you are writing or reviewing an ECR, there are several things you should do. Imagine that you are trying to follow the instructions contained in your ECR. Can you do it? Ask yourself the following questions:

Does my ECR refer to sections of the specification by number and by title?

Sections get moved around all the time in the course of preparing them for outside standards organizations such as SCTE and the ITU-T, so it’s important to reference things by title as well as number. There are boxes designated for this purpose in the EC form.

When I suggest changes, do I include the current state of the text, as well as my proposed change, or do my instructions state something more along the lines of “Change word 6 of paragraph 5 to wumpus”?

See the previous point. Sometimes, when a spec has been changed around like crazy, the only way to find text to be changed is to search for it. If you don’t include the original text, you may be out of luck!

Is my grammar correct? What about my spelling?

Our standards are the face that CableLabs presents to the world, run the spell and grammar check. 

Have I referenced the latest version of the spec?

If you’re not sure that the version you’re working from is the latest, please use the hyperlink on the form and check DocZone, or just ask us.

Do any previous ECNs modify the text my ECR proposes to change?

Make sure that your ECR reflects any previous ECNs that have not been incorporated. Otherwise, it may not get incorporated as you intended! 

Is my formatting correct?

If you aren’t sure how to format your contribution, format it very simply and let the editor folding it in worry about the formatting.
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